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Welcome to Computing@Wheaton! 
 
Our mission at the LIS Technology Support Center is to support, encourage, and empower Wheaton 
College faculty, staff, and students in their use of computer technology. We are committed to providing 
a reliable single-point-of-contact for our users. 
 
The Technology Support Center team is the front line of support for the rest of Information, 
Technologies, and Services.  We can show you how to navigate our network, use the college’s 
standard software, email, file, and print services.  We’ll even fix your computer when it breaks!  If we 
can’t help you, we’ll know who can! 
 
We have developed this overview of Computing@Wheaton for your reference.  If you have questions 
about the information covered or would like to schedule an in-depth training for any of the services we 
provide, just let us know.  Also, please check WheatonCollege.edu/Technology periodically for 
updates to this booklet. 
 
We hope you’ll contact us for support, training, or just to say hello!  We can be reached at extension 
3900, through email at support@wheatoncollege.edu, or stop by to visit us in the Library (we’re on 
the Periodicals Level, just follow the signs!). 
 
 
 
 
 
 

SECURITY REMINDER:  LIS Technology Support will *NEVER* request 
passwords or other personal information via email. Messages requesting 

such information are fraudulent. 
 
 
 
 
 
 

Note about instructions:  If using Windows, always left-click unless the directions 
specifically say to right-click 



Guide Contents 
 
 

  page(s) 

I. Standard Software and Services 4 
   

II. Backing Up Your Files 4 
   

III. insideWheaton 4-5 
   

IV. Data Security 5 
   

V. EMail 6-15 
Changing Your Password ................................................................................................ 6 
Forwarding Your Mail to Another Account ....................................................................... 6 
Automatically Replying to Incoming Messages ............................................................. 6-7 
Barracuda Spam Filter .................................................................................................... 7 
 
Thunderbird ................................................................................................................ 7-12 

Checking Email .................................................................................................... 7 
Reading Messages .............................................................................................. 7 
Sending Mail and Attaching Documents ........................................................... 8-9 
Managing Your Messages and Your Mailboxes .............................................. 9-11 

Custom Mailbox Folders ...................................................................... 9-10 
Creating Custom Mailbox Folders ................................................. 9 
Local Folders .............................................................................. 10 

Transferring Messages to Another Mailbox ....................................... 10-11 
Filters .................................................................................... 10-11 

Creating Filters ................................................................ 10 
Editing Filters ............................................................. 10-11 
Filtering Existing Messages ............................................. 11 

Deleting Mail and Emptying the Trash .................................................... 11 
Directory Services......................................................................................... 11-12 

From the Address Book ..................................................................... 11-12 
From the Composition Window .............................................................. 12 

 
WebMail ................................................................................................................... 12-15 

Logging In .......................................................................................................... 12 
Reading Messages ............................................................................................ 13 
Sending Mail and Attaching Documents ....................................................... 13-14 
Managing Your Messages and Your Mailboxes ............................................ 14-15 

Custom Mailboxes ............................................................................. 13-14 
Creating Folders ......................................................................... 14 

Transferring Messages to Folders .......................................................... 14 
Deleting Mail and Permanently Erasing Messages ................................. 15 

Logging Out ....................................................................................................... 15 
 



VI. MeetingMaker 15-21 
Logging In ..................................................................................................................... 15 
Changing Your Password .............................................................................................. 15 
MeetingMaker Display ................................................................................................... 16 
Calendar Display ........................................................................................................... 16 
Creating and Editing Activities and Banners ............................................................. 16-18 

Inviting Guests to Activities ........................................................................... 17-18 
Reviewing and Responding to Proposals (Yours and Others) ....................................... 18 
Preferences and Other Settings ............................................................................... 19-21 

Preferences ....................................................................................................... 19 
Login ...................................................................................................... 19 
General .................................................................................................. 19 
Notifications ........................................................................................... 19 
Filters ..................................................................................................... 19 
Labels .................................................................................................... 19 
Colors .................................................................................................... 19 

User Info ............................................................................................................ 19 
Display Time Zone ............................................................................................. 19 
View Options ..................................................................................................... 20 
Favorites ............................................................................................................ 20 
Proxy List ........................................................................................................... 20 
Group View ........................................................................................................ 21 

 

VII. Protecting Your System from Viruses 21-23 
Windows ....................................................................................................................... 22 

Manually Updating and Scanning Using ESET NOD32 ..................................... 22 
Updating ................................................................................................ 22 
Scanning ................................................................................................ 22 
Automatic Scans .................................................................................... 22 

What Happens When Your Computer Detects a Virus ....................................... 22 
 
Mac OS X (10.x.x) .................................................................................................... 22-23 

Manually Updating and Scanning Using ESET NOD32 ..................................... 22 
Updating ................................................................................................ 22 
Scanning ................................................................................................ 22 

Manually Updating and Scanning Using iAntiVirus............................................. 23 
Updating ................................................................................................ 23 
Scanning ................................................................................................ 23 

What Happens When Your Computer Detects a Virus .................................................. 23 
 

VIII. Network Folders 23-25 
Windows ....................................................................................................................... 24 
 
Mac OS X (10.1.x and higher) .................................................................................. 24-25 

 

IX. Solving Computer Problems 25 
 

IX. Technology Support Center Resources and Staff 25 
 
 



LIS Technology Support x3900 Technology Guide Page 4 of 25 
Computing@Wheaton  3/12/2012 

I. Standard Software and Services 
The LIS Technology Support Center provides and supports a wide variety of services and software 
packages, including basic productivity (Microsoft Word, Excel, PowerPoint, and Publisher), email, 
and anti-virus.  For a complete list of services and software, visit 
http://wheatoncollege.edu/technology/buy/technology-support-service-level-agreements-
and-standard-software/. 
 
 

II. Backing Up Your Files 
If a pipe were to burst in your office, as happened in Wallace Library Archives and Special 
Collections, and your computer were rendered completely inoperable, how much data would you 
lose?  How many years of effort would be completely gone?  While an event like this is relatively 
rare, it is not impossible; nor is hard drive failure, a virus that deletes your files in such a way that 
they are unrecoverable, fire, or any other unforeseen disaster.  Because of the possibility of these 
extreme events, LIS, in the strongest possible way, URGES you to back up your data regularly.  
Operating Systems and other software can be reinstalled, computer hardware can be replaced, but 
we cannot always recover your documents.  You must take the initiative, therefore, to make sure 
you have current backup copies of your files. 
 
The first step in being able to quickly and easily backup your documents is knowing where files are 
stored on your computer.  Unless you choose a different location, Windows and Mac OS X will 
generally default to the “My Documents” or “Documents” folder.  You can create other folders within 
“My Documents” or “Documents” to help manage and organize your files.  By keeping your files in a 
central location, you’ll only have one folder to backup and won’t need to worry that you might have 
missed or forgotten important files while doing your backup. 
 
The easiest backup method is to “drag and drop” your files on to a USB flash drive or your Network 
Folder (covered in Section VI); if you have a Recordable or Rewriteable CD and/or DVD drive, you 
can burn your documents onto CD/DVD (Mac OS X has burning software built in; if your Dell 
computer has a CD burner, you should have Roxio Easy CD Creator installed).  Your method of 
backup may be determined by the total size of your documents.  You can store up to 2.5Gb 
(2500Mb) in your Network Folder; CDs can hold up to 650Mb or 700Mb, depending on the CD, 
DVDs can hold 4.7Gb or 8.5Gb, depending on the DVD (and whether your burner can use the 
8.5Gb discs), and USB flash drives come in varying sizes. 
 
If you would like a tutorial on backing up your files, or need help determining if your computer has a 
built in CD or DVD burner, please contact the Technology Support Center. 
 
 

III. insideWheaton 
Wheaton has centralized access to many of its core services (Banner, WebMail, WINDOW), plus 
added campus news and information in the new “insideWheaton” website. 
 
To access insideWheaton (whether you’re on-campus or off), you can click on the insideWheaton 
link on Wheaton’s homepage, or go to http://inside.wheatoncollege.edu.  You will need to sign in 
with your Wheaton ID number (wID) and email password.  If you’re new to Wheaton and do not yet 
have a password, click the “Set up your account” link in the sign in area to complete the steps 
needed to create your password. 
 
Once signed in, you can peruse news items and event information, link to various services, launch 
WINDOW, access email, and much more!  You can even customize your “My Stuff” tab to view the 
channels (sections) that are of the most interest to you. 
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Please call x3900 or email support@wheatoncollege.edu if you have any questions, have trouble 
creating your password, are unable to sign in, or cannot access any of the features once inside. 
 
In order to keep your confidential information safe, as well as prevent unauthorized access to 
Banner and other campus resources, don’t forget to sign out of insideWheaton before closing your 
web browser or going to another website.  

 
 
IV. Data Security 

With news of data breaches at companies following guidelines developed to protect confidential 
information, and a data breach law in Massachusetts designed to better inform and protect 
consumers, what can you do to ensure the files and confidential data you use on a regular basis are 
safe?  Here are some steps and suggestions to protect your data. 
 
Identify confidential data – personal information like ID numbers, Social Security numbers, bank 
account information, passwords, and any other piece of information you wouldn’t want someone 
else to have are all components of confidential data and need to be protected (for example – 
Banner downloads, your email password, the tax documents and information stored in WINDOW). 
 
Ways to protect yourself and your data: 

 never give your passwords to anyone, not even Tech Support 

 if you use USB flash drives, only purchase ones that come with encryption/security software 

(and actively use that software – it can’t protect the drive if you’re not using it!!) 

 don’t write passwords down (yes, passwords are tough to remember, but if your computer 

password is written on a sticky note that you’ve attached to the side of your monitor,  

anyone sitting at your computer can gain access to all of your files, thereby making the 

password useless) 

 change passwords often – just as you’re required to change your Wheaton email password 

every six months, you should change your other passwords regularly, too. 

 keep current with operating system and anti-virus patches and updates 

 don’t disable password protection or allow your computer to remember any passwords – 

having to enter a password whenever you need to log in to your computer, an application, or 

a website is nothing compared with the nightmare of trying to recover your identity if it’s 

stolen or facing thousands (or even millions) of dollars in fines if confidential data is lost 

because you didn’t want to be bothered with remembering or typing your passwords. 

 report loss or theft immediately – if your computer, wallet, or documents are lost or stolen, 

report the loss or theft immediately 

 shred papers containing confidential/sensitive data – you should never just discard papers 

containing confidential or sensitive data, shred it first!  (You don’t know who might be going 

through your trash or your recycle bin.) 

 never leave belongings unattended or visibly available – if you are unable to have your 

laptop computer, purse, wallet, or any other belongings with you, don’t leave them out in the 

open for anyone to see, even if that location is locked.  You should instead store them in a 

location that is not visible (your car trunk, for example).  Many cars have gotten broken into 

simply because of ring marks left by suction cups used to hold GPS devices 

 if you sign in to a website, don’t forget to sign out! 
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V. Email 
Wheaton College provides all of its faculty, staff, and students with an @wheatoncollege.edu email 
account.   
 
LIS supports two ways in which to access your email – Thunderbird and WebMail.  Thunderbird 
downloads copies of your email messages from the email server and stores them locally on your 
computer, while WebMail provides direct web-based access to the email server from any computer 
with internet access anywhere in the world.  The option that is best for you depends on your email 
needs.  If you will frequently be using email from multiple computers or want an easy way to check 
your email while traveling, WebMail is recommended; if you use email primarily from one computer, 
Thunderbird is recommended.  Immediately below is some general email information, followed by 
sections providing Thunderbird specific and WebMail specific overviews. 
 
Changing your Password 
For security purposes, you are required to change your password every six months (if you do not, 
the system will automatically change it to something random).  To change your password, visit 
https://password.wheatoncollege.edu.  New passwords MUST be between 8 and 15 characters 
long and must contain at least one capital letter and two numbers.  Passwords cannot contain 
special characters ($,^, #,*, for example) and cannot be a password you have used previously.  You 
can also establish a security question and answer to use if you ever forget your password or don’t 
change it before it expires.  From the password change page, click “Forgot Password?” in the 
Related Links section, or click “Set Password Challenge Question/Forgot Password?” from the 
WebMail login screen to create or use your security question and answer.  If you are having trouble 
logging in to your email, make sure that Caps Lock is not on as passwords are case-sensitive.  If 
you do not create a security question and answer, or do not answer the question correctly, you will 
need to bring your Wheaton ID to the Technology Support Center to get a new email password. 

 
Forwarding Your Mail to Another Account 
You can forward your Wheaton email to another email address for convenience while away from 
campus, or if you have another account where you prefer to receive all of your messages.  Go to 
https://mail2.wheatonma.edu to enable forwarding.  You’ll need to login with your username (your 
“w” ID number) and email password.  Click on the “Rules” link at the top right (above the search 
box).  Click “Edit your message redirection settings” (bottom section) and fill in the address to which 
you want your mail forwarded in the large, open box in that section.  If you want to keep a copy of 
all incoming mail in your Wheaton account, put a check in the box next to “Keep a Copy”.  Please 
note that if you do opt to keep a copy, the next time you check your email using Thunderbird or 
WebMail, all those emails that were forwarded will appear as “new” messages in your Inbox.  You 
may also want to check the box to “Preserve To/Cc Fields” so that forwarded messages appear to 
come directly from the sender rather than from your Wheaton account.  To activate the forwarding, 
make sure the box next to “Redirect All Mail to:” has a checkmark in it, and then click “Save” to save 
your settings.  You can then click “Logout” to exit WebMail. 
 
To disable forwarding, go back to https://mail2.wheatonma.edu.  Log in with your “w” ID number 
and email password.  Click “Rules” and then “Edit your message redirection settings.”  Uncheck the 
box next to “Redirect All Mail to:”.  Click “Save” to save your settings.  You can then click “Logout” 
to exit WebMail. 
 
Automatically Replying to Incoming Messages 
If you’ll be unable to check or respond to your email for an extended period of time (while on 
vacation, for example), you may want to set up an automatic reply that will respond to all of your 
incoming email with a standard message letting the sender know that you are away from email and 
who to contact in your absence if necessary. Just go to https://mail2.wheatonma.edu.   You’ll 
need to login with your username (your “w” ID number) and email password.  Click on the “Rules” 
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link at the top right (above the search box).  Click “Set your vacation message” (bottom section). 
and in the box directly underneath “Message,” enter the text you want people to receive while 
you’re away from your email.  When you are satisfied with the text of your intended response, click 
“Enable” or “Enable Until” (don’t forget to enter an end date!) to start the automatic response.  You 
should also click “Clear ‘Replied Addresses’ List” to reset the address list of people receiving an 
automatic response.  Each email address will receive only one reply while your automatic response 
is active.  When ready, click the “Save” button.  You can then logout. 
 
To disable your Away message, go back to https://mail2.wheatonma.edu, Login with your “w” ID 
number and email password.  Click “Rules” and then “Set your vacation message.”  Select the 
“Disabled” option and then click “Save.”  Logout when done. 
 
Barracuda Spam Filter 
Wheaton has a spam (unwanted email) filter to remove junk email before it reaches your mailbox.  
There are two levels to our Barracuda Spam Filter:  the first level filters known spam, and you will 
never see or know about those messages; the second level filters suspected junk mail and will 
notify you via email of these spam quarantines.  Because no system is perfect, there will sometimes 
be false positives, so be sure to review messages you receive from the Barracuda system to 
whitelist or deliver any messages incorrectly marked as spam.  For more information, go to:  
http://wheatoncollege.edu/technology/started/getting-started-with-email/wheaton-email-
spam-filter/.   
 
 
Thunderbird 
 Thunderbird is an easy to use yet versatile application for reading, composing, and 

managing your email, and comes from Mozilla (which also provides the Firefox web 
browser).  The standard configuration at Wheaton syncs your Thunderbird mailboxes with 

the email server, and you can save messages in “local” folders (on your computer itself) in order to 
archive older mail and free up space In your server account.  Some of the basics of Thunderbird are 
covered below, but if you wish to learn about more advanced features (customizing settings, 
address book, signatures, stationery, etc.) please contact the Technology Support Center. 
 

Checking Email 
Your computer should already be 
configured to automatically check for new 
email at a specified interval, including when 
you first open Thunderbird.  After you 
launch Thunderbird, you will see a screen 
prompting you for your password.  Type in 
your password and either click “OK” or hit 
the <enter> key on your keyboard.  
Thunderbird will check for any new email.  
As long as Thunderbird stays open (even if it’s running in the background or minimized while 
you work on other things), it will remember your password and check mail automatically at 
the specified interval.  Whenever you get new email you will see an envelope appear near 
the time (Windows) or the Thunderbird icon in the Dock will bounce (Mac OS X). 
 
Reading Messages 
To view one of your messages, you can double-click on the message in order to open it in a 
new Thunderbird window, or, if you have the Preview Pane enabled, you can single-click on 
the message and its contents will appear in the preview window (located below your list of 
messages). 
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Sending Mail and Attaching Documents 
You have a few options when you want to send a message to someone.  You can start a 
new message, reply to an existing message, or forward an existing message.  You can also 
attach documents to any outgoing message. 
 
 
 

New Message:  To start a new 
message to someone, simply click 
the Write icon on the main 

Thunderbird toolbar.  The new message 
window will appear. 
 
In the “To:” field, type in the email address 
of the person to whom you want to send 
your message.  If you want to send your 
message to more than one person, create 
a separate line for each recipient.  The 
“From:” will already be listed.  Give your 
message a short topic in the “Subject:” 
field.  You can also choose to Cc (carbon-
copy) or Bcc (blind carbon-copy) your 
email message.  Click the arrow to the left 
of “To:” and make the desired selection, then type in the email address of the Cc or Bcc 
recipient.  Repeat as necessary.  Your “To” and “Cc” recipient(s) will be able to see all the 
addresses that are included in the “To” and “Cc” fields, but will not see any address(es) in 
the “Bcc” field.  “Bcc” recipients will see all “To” and “Cc” addresses, but will not be able to 
tell if you have Bcc’d anyone else. 
 
You can then use the <Tab> key to get down to the body portion of your message.  After 
composing your message, click the “Send” button (far left). 
 
Reply and Reply All:  You can respond to a message you’ve received by making sure the 
appropriate message is highlighted and then clicking either the “Reply” or the “Reply All” 
button from the Thunderbird toolbar.  In the Reply or Reply All window, the message 
headers (To, From, Subject, etc.) will be filled in for you, and the original email will appear in 
the body of the message.  Click at the beginning of the message body and add whatever 
information or comments you wish to send back.  When finished, click the “Send” button. 
 
 

Reply will send your response back to only the original sender.   
 
 

Reply All will send your response back to the sender plus all of the original 
“To” and “Cc” recipients. 

 
Forward:  You can forward a message you’ve received to another recipient.  Make 
sure the message you wish to forward is selected, then click the “Forward” button 
from the Thunderbird toolbar. Type the email address(es) of the person(s) to 
whom you want to send the message.  The other headers will be filled in for you, and the 
original email will appear in the body of the message.  Click at the beginning of the message 
body and add any information you want to include.  When you are done, click the “Send” 
button. 
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Attaching Documents:  You can attach a 
file to any of your outgoing messages.  
With your message window open, just 

click on the “Attach File” button on the Thunderbird 
toolbar.  The Attach File window will open, where 
you can browse to and select the file you want to 
attach.  If you click the “Attach File” button without 
having an outgoing message window open, 
Thunderbird will start a new message for you to 
which you can attach a file.  You should avoid 
attaching files larger than 1.0Mb in size. 

 
 

Managing Your Messages and Your Mailboxes 
To assure Thunderbird’s smooth performance, we recommend that you keep no more than 
2000 messages in each of your mailboxes at any given time.  Moving messages to custom 
mailboxes, applying filters, deleting any unneeded mail, archiving messages, and 
compacting your mailboxes are all ways to help manage both your messages and your 
mailboxes. 

 
Custom Mailboxes Folders 
If you frequently correspond with a particular person or about a particular subject, 
you may want to create a custom mailbox folder specifically for those messages.  
You can then either manually transfer messages to that custom mailbox folder or 
create a filter to automate the transfer (both covered under the next topic).  You can 
further organize your custom mailbox folders by putting them into other folders.   

 
Creating Custom Mailbox Folders 
In the Mailbox frame, right-click (<ctrl>-click on a Mac) on the top listing for 
your email account (may appear as Wheaton, or WebMail, or something 
similar) then select “New.”  In the New Mailbox window, give your mailbox a 
name that will help you identify what messages it contains.  Click “OK.”  You 

should now see your new custom mailbox in 
the Mailbox frame.  Your custom mailboxes 
can hold both messages you receive and 
messages you send.  Your new mailbox 
folder is ready to accept mail and/or other 
mailbox folders (see below).  If moving 
mailboxes, you should only move custom 
mailboxes into folders you create, NEVER 
move the In, Out, or Trash mailboxes into 
one of your folders. 

 
 
Local Folders (Archive Messages) 
If you have messages that you want to keep, but don’t want on the server 
anymore (if your account is over quota, for example), you can store them on 
your computer itself (locally).  In the Folders pane in the main Thunderbird 
window, you should see a listing for Local Folders.  You can create custom 
local mailboxes using the method described above (instead of right-clicking 
on the top listing, right-click on “Local Folders”) and then move messages to 
the local folder as described below. 
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Transferring Messages to Another Mailbox 
The easiest method for transferring a mailbox or the occasional message to a 
custom mailbox folder is to simply drag-and-drop it from the mailbox that it’s in onto 
the destination mailbox.  If there are messages to/from a particular person or 
containing a particular subject that you always want transferred to a specific mailbox, 
you can create a filter to automatically transfer the messages to the desired mailbox. 

 
Filters 
Creating Filters 
With the message selected on which you want to base your filter, go to the 
“Message” menu and select “Create Filter From Message.”  The Filter Rules 

window will come up so that you can further 
define your filter criteria.  If you want to filter 
messages coming FROM a certain person, 
make sure “From” is selected and that the 
person’s email address appears.  If you want to 
filter messages based on a word or phrase 
contained in a message’s subject, select 
“Subject” and type that word or phrase in the 
third field. 

 
The Action section is where you define how you 
want Thunderbird to process messages 
meeting the criteria you just defined.  If you 
want Thunderbird to transfer the messages to a 

custom mailbox, select “Move Message to:” and then select the name of the 
mailbox in the dropdown list. 
 
When you are satisfied with 
both the filter criteria and 
action, click “OK” to activate it.  
The filter is applied only to 
new messages.  You will need 
to manually filter messages 
that already exist in your 
Thunderbird mailboxes (see 
“Filtering Existing Messages,” 
below). 
 
Editing Filters 
To edit or delete any filters you’ve created, select “Message Filters” under the 
Tools menu.  On the left-hand side of the window, click to select the filter you 
want to edit or delete.  To edit, click the “Edit” button.  When you are done 
making changes, click “OK.”  To delete a filter, click once on it, then click the 
“Delete” button.  When completely done, just close the window. 
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Filtering Existing Messages 
 If you only have a few filterable messages in your mailboxes, 

you can “process” them individually (drag-and-drop them onto 
the appropriate mailbox, delete them, etc).  If you have many 
filterable messages, you can make Thunderbird apply your 
filter to pre-existing messages.  Open the mailbox you want to 
process, then choose “Run Filters on Folder” from the Tools 
menu.  Your messages will be checked and filters applied as 
needed.  You will need to repeat this process for all of your 
existing mailboxes if you want them checked for filterable 
messages.  Please note that you may want to compact your 

mailboxes after filtering existing messages. 
 
Deleting Mail and Emptying the Trash 
You should periodically go through your mailboxes to delete messages you no longer 
need.  You can delete messages one at a time or as a group.  Select the message(s) 
you want to delete (to select a continuous series of messages, click the first 
message in the series, then <shift>-click the last message in the series; this will 

select ALL the messages in between the first and last messages.  To select 
a group of non-continuous messages, <ctrl>-click or <apple>-click on each 
message), then click the Delete button on the Thunderbird toolbar.   

 
After you have moved the message(s) you wish to delete to 
Thunderbird’s Trash mailbox (separate from the Windows 
Recycle Bin or the Mac Trash), you need to finish the 
deletion process by emptying the trash.  To empty the 
trash, right-click on the Trash mailbox (control-click on 
Mac) and select “Empty Trash.”  You will NOT get a delete 
confirmation, so be certain that you really want to get rid of 
those messages.  Before you empty the Thunderbird trash, 
you can, if necessary, open the Trash mailbox to move 
item(s) to other mailbox(es).  Once you have emptied your 
trash, however, you will not be able to recover those 
deleted messages. 
 

Directory Services 
You can use Thunderbird to find email addresses for members of the Wheaton community.  
Please note that Directory Services will only work on-campus or through Wheaton’s VPN.  
You can find addresses from within your Address Book or when composing a message. 
 

From the Address Book 
Click on the “Address Book” button on the main Thunderbird toolbar. 
 
In the Address Book window, click once on the “Wheaton Directory” 
listing in the left pane.  In the top right search field, enter in your search criterion.  
You can do partial name searches to increase your chances of finding the person for 
whom you’re looking (for example, searching for “dur” will list all the people at 
Wheaton who have “dur” in either their first or last name). 
 
If you right-click (control-click for Mac) on a person’s email address and then click 
“Write,” Thunderbird will open a new message addressed to that person. 
 
When done searching, simply close your Address Book window. 
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From the Composition Window 
You can also look up an address while writing a message.  If you don’t see the 
Contacts pane to the right of your message, click the “Contacts” button.  From the 

Address Book pulldown, select “Wheaton Directory.”  Enter your search 
criterion into the “Search for:” field.  The search is live and matches will 
appear (and constrain) as you type.  If you double-click on a match, the 

address will be added as a To recipient.  You can also use the “Add to To:” or “Add 
to Cc:” buttons as needed (at the bottom of the Contacts pane). 
 
 
 

 
WebMail is a great tool if you frequently use multiple computers to check your email, or if you’re 
away from campus and want a way to quickly check or compose messages.  WebMail provides a 
simple interface that allows you to read, send, and manage your messages directly from the email 
server.  You can use WebMail from any computer, provided it is connected to the internet, 
anywhere in the world.  Some of the basics of WebMail are covered below, but if you wish to learn 
about more advanced features (customizing settings, address book, signatures, etc.) please contact 
the Technology Support Center. 

 
Logging In 
Launch either Internet Explorer or 
Firefox.  You can either select 
WebMail from the top right corner of 
the Wheaton homepage 
(http://wheatoncollege.edu) or you 
can go directly to 
https://mail2.wheatonma.edu.   
At the login screen, enter your 
username (your “w” ID number) and 
email password, then click “Enter.” 
 
After you log in, you’ll have access to all your messages that are currently on the server.  
The latest WebMail configuration is designed to look like desktop clients such as Outlook 
and Thunderbird.  The number of unread messages appears in red next to the mailbox, and 
there is a preview pane in the bottom right for easy reading.  
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Reading Messages 
To read a message, simply single-click on it.  The message will appear in the preview pane 
below the list of messages, and you can read it directly from there.  If you double-click on 
the message, it will open in its own window.  Click the red “X” in the upper right hand corner 
of the message window to close it. 
 
Sending Mail and Attaching Documents 
As with Thunderbird, you have a few options when you want to send a message to 
someone.  You can start a new message, reply to an existing message, or forward an 
existing message.  You can also attach documents to any outgoing message. 

 
New Message:  To start a new message to someone, simply click “New Message” in the 
upper left corner of the WebMail window.  The new message window will appear.  
 

In the “To:” field, type in the email 
address of the person to whom you 
want to send your message.  If you 
want to send your message to more 
than one person, separate their email 
addresses with commas.  Give your 
message a short topic in the 
“Subject:” field.  You can also choose 
to Cc (carbon-copy) or Bcc (blind 
carbon-copy) your email message.  
Click “Cc:” or “Bcc:” to add those 
recipients.  Your “To” and “Cc” 
recipient(s) will be able to see all the 
addresses that are included in the 
“To” and “Cc” fields, but will not see 
any address(es) in the “Bcc” field.  
“Bcc” recipients will see all “To” and 

“Cc” addresses, but will not be able to tell if you have Bcc’d anyone else.  
 
You can then use the <Tab> key to get down to the body portion of your message.  After 
composing your message, click “Send” (just above the “Compose” tab). 
 
Reply and Reply All:  You can respond to a message you’ve received by first opening the 
message and then clicking either the “Reply” or the “Reply To All” button from the toolbar 
located between the list of messages and the message preview.  In the Reply or Reply All 
window, the message headers (To, From, Subject, etc.) will be filled in for you, and the 
original message will appear in the body of the message.  Click at the beginning of the 
message body and add whatever information or comments you wish to send back.  When 
finished, click “Send”.  Reply will send your response back to only the original sender.  Reply 
All will send your response back to the sender plus all of the original “To” and “Cc” 
recipients. 
 
Forward:  You can forward a message you’ve received to another recipient.  Make sure the 
message you wish to forward is open, then click the “Forward” button from the toolbar 
located between the list of messages and the message preview.. Type the email 
address(es) of the person(s) to whom you wish to send the message.  The other headers 
will be filled in for you, and the original message will appear in the body of the message.  
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Click at the beginning of the message body and add any information you want to include.  
When you are done, click “Send”. 
 
Attaching Documents:  You can attach a file to any of your outgoing 
messages.  With your message window open, click “Attach a file” 
(underneath the message subject field), and then click the “Browse” 
button.  The “Choose file to upload” window will open, where you can 
browse to and select the file you want to attach.  You should avoid 
attaching documents larger than 1.0Mb. 
 
Managing Your Messages and Your Mailboxes 
To assure WebMail’s smooth performance, we recommend that you keep no more than 100 
messages in each of your mailboxes at any given time.  Moving messages to custom 
mailboxes, applying filters, and deleting any unneeded mail are all ways to help manage 
both your messages and your mailboxes. 

 
Custom Mailboxes 
If you frequently correspond with a particular person or about a particular subject, 
you may want to create a custom mailbox specifically for those messages (in 
WebMail mailboxes are called folders).  You can then either manually transfer 
messages to that folder or create a filter to automate the transfer (both covered 
under the next topic).   
 

Creating Folders 
Right-click on your Wheaton ID number in the folders frame at the left side of 
the WebMail window (where your mailbox list is, just above “Inbox”) and 
select “Create Folder.”  In the “Name” field, give the folder a name that will 

help you identify what messages it contains.  
Click “Create.”  You should now see your 
new folder in the folder list (it will appear in 
the lower half, where all your custom 
mailboxes are; you may need to scroll down 
to see it).  Your custom folders can hold both 
messages you receive and messages you 
send.  By default, WebMail will display who 
sent the messages (remember, for your 

outgoing messages, that’s you).  You can also display to whom a message is 
sent by editing your folder display options.  Please call Technology Support 
for assistance with changing this setting. 
 
 

Transferring Messages to Folders 
You can manually transfer messages to custom folders individually or as a group.  
To move a single message, click-and-drag the message from the mailbox that it’s in, 
then drop it on top of the mailbox where you want it.  For consecutive messages, 
click the first message to select it, then shift-click on the last message to highlight 
everything in between.  You can then click-and drag one of the highlighted messages 
on top of the desired mailbox to move the entire group.  If you hover over the 
envelope icon to the far left of the message list, you can click in the box to select the 
message.  Do this for all non-consecutive messages you wish to select.  You can 
then click-and drag one of the highlighted messages on top of the desired mailbox to 
move the entire group.   
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Deleting Mail and Permanently Erasing Messages 
You should periodically go through your mailboxes to delete messages you no longer 
need.  You can delete messages one at a time or as a group.  You can choose to 
delete messages as you read them by clicking the “Delete” button in the toolbar 
(either at the top of the message list, or in the area between the message list and the 
message’s preview).  You can also select one or multiple messages to delete from 
your Inbox.  Just click in the box next to the message(s) you want to delete, then 
click either of the “Delete” buttons located above and below the mailbox list.  If you 
want to select all the messages on the screen, click the checked box next to “From” 
at the top of your message list. 

 
In order to permanently erase the messages you’ve marked for deletion, right-click 
on “Trash” (or “Trash Can”) in the left hand column and select the “Empty…” option.  
Please note that you will NOT be prompted to verify the emptying of the trash, and 
once messages are purged, they CANNOT be recovered. 
 

Logging Out 
When you are done using WebMail, don’t forget to click “log out” (top right) to properly end 
your WebMail session. 

 
 
 

VI.  
MeetingMaker, established in 1989, is a program dedicated to calendaring in a work environment, 
and is designed to manage scheduling for everything from individuals to resources (rooms, 
equipment, etc.). 

 
Logging In 
When you launch MeetingMaker, you’ll be prompted 
to log in.  When logging in for the first time, make 
sure the Server is set to “mmserver”.  If the server 
information is missing or incorrect, please contact the 
Technology Support Center. 
 
Your log in name is your Wheaton ID number (your “w” ID number), and the default password for 
new MeetingMaker users is your email password.  Enter in your Name and Password then either 
press <enter> on your keyboard or click “Sign In.”  If you are having trouble logging in, make sure 
that Caps Lock is not on as passwords are case-sensitive.  If you still cannot login or have forgotten 
your password, please contact the Support Center at x3900. 
 
Changing Your Password 
Whenever you change your email password, your Meeting Maker password is changed to match.  If 
you would like to change your Meeting Maker password to something other than your email 
password, under the “Edit” menu, select “Preferences.”  On the “Login” tab, enter your current 
password, the new password you want to use, and then verify the new password.  Click “OK.”  The 
next time you sign in you will need to do so using the new password you just created.  Just 
remember that the next time you change your email password, it will also change your Meeting 
Maker password. 
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Meeting Maker Display 
You can view the Meeting Maker 
toolbar three different ways:  full (left), 
medium (middle), or compact (right).   
 
If you choose the compact version of 
your toolbar, when you move your 
mouse over one of the buttons, the 
text will display in a yellow box next to 
the button.  If you mouse over the 
mini-calendar (bottom button), the 
Monthly Navigator will pop-up for you 
to make selections. 
 
From the toolbar, you can create new 
activities, banners, and To Do items, 
as well as change how your calendar 
is displayed. 
 
To adjust the size of the toolbar, 
mouse over the three vertical lines 
separating the toolbar from your 
calendar, until your mouse changes to 
↔, then click and drag the toolbar in or 
out. 
 
Calendar Display 
 The standard (weekly) MeetingMaker display is broken up into two sections, banners 

and scheduled activities. The differences between activities and banners are that 
banners have no time frame associated with them, and you cannot invite people to 
them.  Banners can be used to remind you of upcoming “events” (holidays, birthdays, 
anniversaries, vacations, etc.) that do not require a specific amount of time out of your 
daily schedule.  Activities and Banners can be set to recur in a myriad of ways (daily, 
weekly, monthly, or annually, which can all be further customized to meet your 
needs). 

 
The unshaded section of the activity area indicates the MeetingMaker default work 
week.  You can change your default work week to accurately reflect your schedule by 
selecting “User Info” from the “Edit” menu and changing the information located at the 
bottom of the User Information window. You can also view your monthly calendar by 
selecting it from the “View” menu.  Use the arrows to the immediate left and right of 

the month name on the toolbar calendar to move backward (left) or forward (right) a month.  Use 
the “outer” arrows to move backward (left) or forward (right) a year.  Click on the “Go To Today” 
button above the toolbar calendar to bring you back to the current date. 
 
Creating and Editing Activities and Banners 
To create a MeetingMaker Activity or Banner, you can either go to the 
“File” menu to select the appropriate option (New Activity or New 
Banner), or you can go to the date on which you want the entry created 
and “click and drag” to select the time frame for your activity or “click and 
drag” in the banner section to create a banner listing.   
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On the “Details” tab of the creation window, give your activity or banner a title and, if necessary, a 
location.   
 
Verify that the date, start time, and duration are correct.  Schedule recurring activities by clicking on 
the drop-down list (for new banners/activities, it defaults to “Occurs once”) then selecting desired 
frequency and options.  If there is no established end date for your recurring activity (a standing 
monthly meeting, for example), click in the box next to “Ongoing.” 
 
You can add information about your activity in the “Agenda” area.  You can also copy and paste text 
from other programs (Microsoft Word, for example) into the agenda box. 
 
The “Options” tab allows you to change your desired reminder interval from the default (changes to 
your reminder options will NOT change your default reminder setting), as well as assign your 
activity a label.  You can also mark your activity as “Private” (others viewing your calendar will see 
that you have something scheduled for a particular date/time, but will not know what) or “Flexible” 
(time frames for flexible activities will not appear as “blocked,” or “busy,” when others invite you to 
meetings). 
 
Click “Create Activity” or “Create Banner” at the bottom right of the window.  To edit an activity or 
banner, simply double-click it, make the necessary modifications, then click the “Update” button.  If 
you need to modify a recurring banner, you must first delete the original banner then re-define it 
with the new options. 
 
To delete a banner or an activity after it’s already been created, click on it once to highlight it, then 
press the <delete> or <backspace> key on your keyboard.  For single-occurrence events, you will 
be prompted to confirm the deletion.  For recurring events, you can choose to delete only the 
selected occurrence, the selected and all future occurrences, or all occurrences of the activity.  You 
will not be allowed to delete meetings that you did not propose, but you can edit the meeting to 
change your attendance option to “No.” 
 

Inviting Guests to Activities 
You can invite others to attend the activities you create in 
MeetingMaker (when guests are invited, the activity is then 
considered a “meeting”).  From the activity creation window, 
just click the “Guests” tab then click “Edit List” (bottom of 
guest list) to add desired attendees.   
 
If it’s the first time you’ve invited guests to an activity, MeetingMaker will automatically list all 
users.  From then on, whenever you invite guests, MeetingMaker will go to the last guest list 
you used. 
 
Use the pull-down menu at the top left to select other lists, like your most recent invitees.  
Your guests can be required (they MUST attend your proposed activity) or optional (they’re 
not necessary for your activity, but you’d like to include them).  You can also choose to Cc 
or Bcc certain people, just to inform them of your proposed activity (Cc-ing or Bcc-ing does 
not invite people to your activity, but merely informs them of it). 
On the Guests window, all possible guests will appear on the left hand side, while all guests 
to be invited or informed, including you, will appear on the right.  To invite or inform a guest, 
click once on his/her name in the left-hand box to highlight it, then click your desired option 
(Required, Optional, Cc, or Bcc) to add him/her to the included guests on the right-hand 
side.  Please note that if you simply double-click on a name, MeetingMaker will assume that 
the person is a REQUIRED guest.  If there is a line going through the icon next to a guest’s 
name (looks kind of like a person wearing a seatbelt), that means the time frame you’ve 



LIS Technology Support x3900 Technology Guide Page 18 of 25 
Computing@Wheaton  3/12/2012 

selected for your event overlaps with another activity already on the calendar of the person 
in question.  Any perceived unavailability of a guest will NOT prevent you from sending your 
proposal.   
 

Once all your desired guests are in place, click “OK.”  Next 
to the person’s name in the guest list is a snapshot of 
his/her schedule.  The currently defined time frame for the 
meeting is outlined in blue.  You can drag the box to adjust 
the start time and/or duration as necessary to accommodate 
your guests’ schedules.  You can also click “Autopick” 
(lower right) to have Meeting Maker jump to the next 
available block when the calendars of you and all your 
desired guests are open.  When using Autopick, verify that 

the date and time selected best suits your needs, as Meeting Maker’s only goal for Autopick 
is finding an open block of work time for all included participants.  It cannot account for your 
project or deadline needs, or for the importance of your meeting. 
 
When you are finished compiling your guest list and adjusting the schedule if necessary, you 
can either click the “Details” tab to get back to the activity details or you can click the “Create 
Meeting” button in the lower right corner to send the activity details to your selected guests.   
 

Reviewing and Responding to Proposals (Yours and Others) 
When you send or receive a meeting or a To-Do proposal, a copy of it is held for a certain amount 
of time, depending on your preferences (covered below).  To view these proposals, select 
“Proposals” from the “Window” menu. 
 
The proposals are separated into four different categories:  Received (proposals from other people), 
Sent (proposals you’ve sent), Declined (items to which you’ve replied that you cannot attend/do), 
Auto-accepted (items that have been auto-accepted for you by Meeting Maker – see information on 
the “General” Preferences tab, below). 
 
When you receive a new meeting or To-Do proposal, it will appear in the Proposals window.  
Depending on your preferences, the Proposals window may automatically open and come to the 
front.  Double-click the proposal listing to open it.  You can then review the proposal and determine 
whether you can or cannot accept the proposal, or if you want to decide later.  Select the 
appropriate response in the lower left of the proposal window, make any necessary comments on 
the “Options” tab, then click the “Reply” button.   
 
When you choose to accept a proposal, the item will be added to your calendar or your To-Do list, 
as appropriate.  If you refuse the proposal, the listing can be accessed later in the “Declined” 
section of the Proposals window.  If you choose decide later, the proposal will remain under “Active 
Proposals” in the Proposals window.  As soon as you accept or decline a proposal, the person with 
whom the proposal originated will be notified of your decision.  Unless the sender cancels the 
proposal, you can change your response any time before the meeting or To-Do item takes place, 
either by opening the proposal from the Proposals window, or, if you last replied “Yes” to the 
proposal, by double-clicking the item itself. 
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Preferences and Other Settings 
There are many ways in which you can customize MeetingMaker in order to make it more useful for 
you.   
 

Preferences 
In the “Edit” menu (the “MeetingMaker Calendar” menu on Mac OS X), select “Preferences” 
to change your MeetingMaker password and settings related to your calendar.  When done 
editing your preferences, click “OK.” 
 

Login 
The “Login” tab is where you can change your MeetingMaker password.  For security 
purposes, you should NOT have MeetingMaker remember your password to log you 
in automatically.  If desired, you can have MeetingMaker inform you if its connection 
to the MeetingMaker server is lost.  Please remember that changing your password 
in MeetingMaker will have no effect on your email password. 
 
General 
Use the “General” tab in MeetingMaker Preferences to control your user lists, how 
long meeting proposals are active, and set your email information (the “Local SMTP 
Host” is “smtp.wheatonma.edu”).  If you want Meeting Maker to automatically accept 
proposals that occur during unscheduled time, you can check “Auto-accept during 
free time” in the “Proposal Latency” section. 
 
Notifications 
On the “Notification” tab in Preferences, you can customize how MeetingMaker 
notifies you of meeting proposals and reminds you of your upcoming activities.  You 
can also have Meeting Maker pencil new proposals in to your calendar by checking 
the “Pencil in to Calendar” box in the “When New Proposals Arrive” section; what this 
feature does is allow you to view proposals on your schedule without/before actually 
accepting them.  
 
Filters 
You can edit your Contact categories, To-Do Categories, and To-Do priorities on the 
“Filters” Preferences tab. 
Labels 
Color coding can be a useful way to organize your calendar, but when setting your 
activity options, color definitions like “Label 1” or “Label 12” have no meaning.  In the 
“Labels” tab of Preferences, you can assign categories to your colors. 
 
Colors 
Don’t like the system background colors Meeting Maker is using to display your Work 
Hours, non-work time, etc.?  Change them on the “Colors” tab in Preferences.  Just 
click on the color box next to the category you want to change, and select a new pre-
defined color or click anywhere on the spectrum to customize your colors. 

 
User Info 
To set your default work hours and/or edit your information, go to the “Edit” menu and click 
on “User Info.”  Make any desired additions or changes then click “OK.” 
 
Display Time Zone 
Select “Display Time Zone” from the “Edit” menu to change your selected Time Zone. 
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View Options 
You can change the font, font size, and other calendar options by 
selecting “View Options” from the “Edit” menu (you can also select 
“Edit View Options” from the Meeting Maker toolbar).  You can check 
“Classic View” to have your calendar display look more like the 
previous version of Meeting Maker.  You can also choose how many 
days you want the weekly display to show, if you want to view 
weekends (uncheck “Work days only”), and choose the weekday and 
time Meeting Maker should open display when launched (always have 
Sunday appear as the left-most day, for example, regardless of the 
current day, and start the calendar at 7:30am). 
 
Favorites 
If you regularly schedule meetings with certain people, you can add them to your 
MeetingMaker Favorites for easy access when proposing activities.  Under the “Edit” menu, 
select “Favorites,” then add guests from the “All Users” list or your Address Book the same 
way you would add guests to your proposals.  When done editing your Favorites, click “OK.” 
 
To use your Favorites when inviting guests, simply select “Favorites” from the dropdown 
menu (at the top of the left-hand side of the “Guests” tab), then add guests from the list as 
you normally would. 
 
Proxy List 
You can allow others to access your calendar by making them a proxy.  The access you 
grant can be Read/Write (the person can view AND create/edit activities) or Read Only.   
 
To make someone a proxy to your calendar, select “Share Calendar” from the “Proxy” menu.  
You can then go to your Favorites or scroll through all users.  To give someone proxy 
access to your calendar, click once  on his/her name in the left-hand window to highlight it, 
then click on the “Read/Write” or “Read Only” button as desired.  The person’s name will 
then move to the “Share your calendar with” list on the right.  MeetingMaker will assume 
Read/Write access if you just double-click a person’s name.  When you are done defining 
your proxies, click “OK.” 
 
To remove proxy access to your calendar, go back to “Share Calendar” under the “Proxy” 
menu. In the “Share your calendar with” list on the right, select the person whose access 
you want to remove, then click the “Remove” button. 
 
To view a calendar you have proxy access for, simply choose it from the “Proxy” menu.  You 
can create activities on a calendar to which you have Read/Write access, but you should 
avoid proposing meetings (activities with guests) from it as you may encounter oddities 
(especially when trying to find a time when all guests are available).  As a general rule, you 
should only propose meetings from a calendar to which you are directly connected (logged 
in), not one to which you are proxied. 
 
If you know you have proxy access to a colleague’s calendar, 
but the calendar does not appear under your “Proxy” menu, 
you need to add it to your menu.  To do so, click “Edit Favorite 
Proxies” in the “Proxy” menu.  Double-click each desired proxy 
from the Available Proxies list (left side) to move it to “Proxies 
shown in list” (right side).  
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Group View 
You can view a snapshot (scheduled blocks of time, without showing what the blocks are) of 
the calendars for a group of individuals and the group’s composite calendar by using “Group 
View” in the “View” menu.  When going to Group View for the first time, only you will appear 
in the group list.  To add people to the group, click on “Edit List” at the bottom of the group 
list, and add to your group the same way you select guests for meetings.  When done 
editing your group list, click “OK.”  The combined scheduled times appears next to 
“Everyone” at the top of the list, followed by each group member and his/her individual 
schedules. 
 
You do not need to have proxy access to someone’s calendar in order to view the snapshot 
in Group View. 

 
 

VII. Protecting Your System from Viruses 
 Computer viruses are very serious threats, especially now that high-speed internet access is 

prevalent and programmers have developed viruses with means of self-propagation 
(worms).  The “payload” (what happens as a result of infection) of newer viruses and worms 

can go far beyond your computer – many are written to spy on your computer and internet activities, 
and to steal account numbers and passwords.  These kinds of viruses and worms enable identity 
theft, which can be a long and costly process from which to recover.  Many of the worms that have 
made headlines recently also have the capability, just by their methods of spreading, to crash entire 
networks.  Protecting your computer, and therefore yourself and the entire Wheaton community, 
from these, as well as the over 100,000 (and counting) other threats out there, is EXTREMELY 
important.   
 
You need to make sure that not only does your computer have anti-virus software installed, but that 
the virus definitions are up-to-date.  New viruses are continually being programmed, so yesterday’s 
definitions can do nothing to protect you from the virus that may be released tomorrow.  Faculty and 
staff computers are already equipped with ESET NOD32 (Windows, some Macs) or iAntiVirus 
(Mac), which are configured to automatically update on a daily.  You may occasionally, however, be 
asked to manually update this software, if definitions and/or patches to fix immediate virus threats 
become available (instructions below).  The Technology Support Center also recommends weekly 
scans of your computer to further ensure that your system is virus free (instructions below). 
 

Windows 
Manually Updating and Scanning ESET NOD32 

Updating 
1. Right-click on ESET’s target icon located near the time on the 

Windows Taskbar (you may need to click the < to show hidden 
icons) and select “Update”  

2. Wait for Update process to complete 
3. Click “OK” when process is done 
4. Click the “X” in the upper right corner of the ESET NOD32 window to 

close it. 
 
Scanning 
Since scanning your entire computer for viruses may take a while, you might 
want to start the process before you leave for lunch or any other time you 
expect to either be away from or not using your computer for a while. 
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1. Right-click on ESET’s target icon located near the time on the 
Windows Taskbar (you may need to click the < to show hidden icons) 
and select “Computer Scan”  

2. Select which drives you would like to 
scan (in most cases, you only need to 
select “C:\” 

2. Click “Scan” 
3. Wait for the scan to run.  ESET will 

attempt to automatically repair any 
infected files it finds, and will keep a 
log of all infected files, whether able 
to clean them or not.  If there are 
infected files that ESET is unable to 
disinfect, contact the Technology 
Support Center for help dealing with 
them.  Make a note of the virus(es) infecting any non-repaired file(s).  
Please do not delete these files without contacting the Technology 
Support Center, as they may be critical to the operation of your 
computer. 

4. Click OK to complete the scan 
5. Click the “X” in the upper right corner of the ESET NOD32 window to 

close it. 
 

 
Mac OS X (10.x.x) 

Manually Updating and Scanning Using ESET NOD32 
Updating 
1. Click ESET’s target icon in the upper right corner of your desktop 
2. Wait for the update process to complete 
3. If necessary, click “OK” when the process finishes 
4. Close the ESET window 
 
Scanning 
Since scanning your entire computer for viruses may take a while, you might 
want to start the process before you leave for lunch or any other time you 
expect to either be away from or not using your computer for a while. 
1.  Click ESET’s target icon in the upper right corner of your desktop 
2. Click “Computer Scan” 
3. Select the drive(s) you want to scan (in most cases, you only need to 

select “Macintosh HD”) 
4. Click “Scan” 
5. Wait for the scan to run.  ESET will attempt to automatically repair any 

infected files it finds, and will keep a log of all infected files, whether 
able to clean them or not.  If there are infected files that ESET is 
unable to disinfect, contact the Technology Support Center for help 
dealing with them.  Leave the window containing the list of 
uncleanable files open.  Please do not delete these files without 
contacting the Technology Support Center, as they may be critical to 
the operation of your computer. 

6. If necessary, click “OK” when the scan finishes 
7. Close the ESET window 
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Manually Updating and Scanning Using iAntiVirus 
Updating 
1. Click the iAntiVirus icon in the upper right corner of your desktop 
2. Click “Smart Update” 
3. Wait for the update process to complete 
4. Click “Close” 
5. If necessary, close the iAntiVirus window 
 
Scanning 
Since scanning your entire computer for viruses may take a while, you might 
want to start the process before you leave for lunch or any other time you 
expect to either be away from or not using your computer for a while. 
1. Click the iAntiVirus icon in the upper right corner of your desktop 
2. Click “Show iAntiVirus” 
3. In the iAntiVirus window, click “Scan My Mac” 
6. Choose between Quick Scan, Normal Scan, or Custom Scan (quick 

will scan system files and common areas, normal will scan your entire 
computer, custom will let you choose which folder(s) you want 
scanned) 

7. Click “Start Scan” 
8. Wait for the scan process to complete 
7. Click “Done” when update is completed 
8. Close the iAntiVirus window 

 
What Happens When Your Computer Detects a Virus 
When your computer detects a virus-infected file, you will get an alert message notifying you 
of the name and location of the infected file as well as what virus it contains.  If the infected 
file is not listed as cleaned, deleted, or quarantined, please notify Technology Support. 

 
 

VIII. Network Folders 
Everyone with a Wheaton email account also has a folder on the network.  You can use your 
Network Folder to store files, as a convenient location for accessing and/or saving files when 
working on a computer other than your own, or to back up important files (for archival purposes, you 
should burn CDs or DVDs instead).  From Windows, you also have “drop” access to everyone 
else’s Network Folder in order to exchange large documents, rather than emailing them as 
attachments.  Please note that you will not be able to see the contents of anyone’s dropbin or 
private folders, nor will anyone be able to see the contents of your dropbin or private folders; files to 
be exchanged will be done by doing a blind “drag and drop.”  Your folder size is limited to 2.5Gb.   
 
You cannot use FTP/Fetch to access your network folder.  If you need to access your network 
folder from off campus, you must log in to the Virtual Private Network (VPN), then use the 
instructions below for connecting.  For VPN access, go to: https://vpn2.wheatonma.edu. 
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Windows 
Click on the Start menu and select “Run.”  In the “Open:” field, enter 
“\\netspace.wheatonma.edu” (without the quotes) and click “OK.”  

When prompted for a username and 
password, log in using “WC\” (without the 
quotes) followed by your wID number as the username and your email 
password as the password (“WC\w00000000”, for example). 

 
After logging in, you will see two items: “content” and “shared.” 
“Shared” stores all the departmental shared folders, while “content” 
holds everyone’s personal network folder.  The folders are arranged 

by Wheaton affiliation (affiliate, faculty, staff, and student).  Double-click on your affiliation 
and then on your folder (all folders are named using the lastname_firstname convention). 
 
When you open your Network Folder, you will see three folders that are created 
automatically:  dropbin, private, and public.  The “dropbin” is where other people can leave 
files for you.  “Private” is where you should put files that you don’t want anyone else to see.  
Use the “public” folder for items you want anyone at Wheaton to be able to access.  You will 
not be able to copy files to this main level of your network folder, you must place files into 
one of the pre-defined folders. 
 
If you need to leave a file for someone else, you can access his/her dropbin by double-
clicking on his/her affiliation and then his/her personal folder.  You can then drag and drop 
your file on top of his/her “dropbin” folder. 
 
 
Mac OS X (10.1.x and higher) 
With the Finder active (if necessary, click on the Finder [face] icon in 
your Dock), click on the “Go” menu and select “Connect to Server…”   
 
In the connection window, enter “smb://netspace.wheatonma.edu” 
(without the quotes) and click “Connect.”   
 

When prompted for a username and password, verify that “WC” 
appears in the “Workgroup or Domain” field, enter your wID number 
for “Name,” and enter your email password for “Password.”  When 
ready, click “OK.” 

 
 
After authenticating, you will be prompted for which volume to 
mount to your desktop: “content” or “shared.” “Shared” stores 
all the departmental shared folders, while “content” holds 
everyone’s personal network folder.  When connecting to your 
personal network folder, choose “content” and then click “OK.” 
 
Within “content,” the folders are arranged by Wheaton affiliation (affiliate, faculty, staff, and 
student).  Double-click on your affiliation and then on your folder (all folders are named 
using the lastname_firstname naming convention). 
 
When you open your Network Folder, you will see three folders that are created 
automatically:  dropbin, private, and public.  The “dropbin” is where other people can leave 
files for you.  “Private” is where you should put files that you don’t want anyone else to see.  
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Use the “public” folder for items you want anyone at Wheaton to be able to access.  You will 
not be able to copy files to this main level of your network folder, you must place files 
into one of the pre-defined folders (anything that you had at the top level of your 
fileserver network folder will be in the “toplevel” folder located in the 'private' folder. 
 
If you need to leave a file for someone else, you will need to connect to netspace from a 
Windows computer, using the directions on the previous page. 
 
 

IX. Solving Computer Problems 
If you are experiencing computer troubles, there are a couple of things you can do before calling the 
Technology Support Center.  First, try shutting the computer down, waiting a few seconds, then 
restarting.  Restarting the computer will take care of many general performance-related issues.  If 
necessary, while the computer is off, make sure your connections/cables are secure.  If the problem 
is printing related, try turning off the printer, waiting a few seconds, then turning it back on.  And if 
you’re having trouble logging in to your Network Folder, WebMail, Thunderbird, or anything else 
that requires a password, make sure that you do not have Caps Lock on, as passwords are case-
sensitive. 
 
You can also search the LIS knowledgebase for answers to common questions and solutions to 
common problems.  Just go to http://fm.wheatonma.edu/ProbFix/frames.html, enter in search 
criteria, then click “Search.”  Please note that if you hit the <enter> key on your keyboard you will 
get an error message.  You must click the “Search” button. 
 
If you do need to call the Technology Support Center, make sure you’ve written down any error 
messages you’ve received.  Let us know what you were trying to do, what any error messages 
were, and what you may have tried to fix the problem.  We also need to know if any of your settings 
have changed or if any new software has been installed recently (by you or by someone else). 
 
While talking with Technology Support Center staff, please make sure to let the person know if 
he/she is going too quickly or if you would like any further explanation.  
 
 

X. Technology Support Center Resources and Staff 
For more information about the many and varied services provided by LIS, visit 
WheatonCollege.edu/Technology or call the Technology Support Center. 
 
The Technology Support Center is comprised of a team of knowledgeable and dedicated students 
who work alongside the following full-time professional staff: 
 
Sue Morgado (smorgado, x3754); Director of Technology Support; Assistive Technology Specialist 
Carol Specht (cspecht, x5680) Assistant Coordinator; purchasing and sales 
Jessie Durand (jdurand, x3907); Technical Specialist; Support Center student liaison; PC and Mac 

support, student supervision 
Jenn Horton (jhorton, x3725); Senior Technical Specialist; PC and Mac support 
Morgan Holland ’94 (mholland, x3929); Technical Specialist; Mac and Windows support 


